This Readme contains important information about AutoCAD® Land Desktop 2009, and AutoCAD® Civil 3D Land Desktop Companion 2009, that may not be included in the product documentation.

Unless otherwise noted, the information contained in this Readme applies to both versions of Land Desktop—that is, AutoCAD Land Desktop 2009 and AutoCAD Civil 3D Land Desktop Companion 2009.

Because AutoCAD Land Desktop is built on AutoCAD® and AutoCAD Map® 3D, the Readmes for those products are included with this Readme.

**Topics in this section**

- Installation
- General

[Please send us your comment about this page](#)
Installation

Use Setup.exe to Install

Installing AutoCAD Land Desktop 2009 using the MSI file results in an invalid installation. You must use the setup.exe file to install AutoCAD Land Desktop 2009.

Menu Bar Display

After installing AutoCAD Land Desktop 2009, the menu bar is turned off (does not display). To display the menu bar, do the following:

1. Click the Workspace Switching icon located in the application status bar, at the bottom right side of the application window.

2. In the Workspace Switching menu, click the Land Desktop workspace.

The menu bar is displayed. Clicking any workspace from the Workspace Switching menu activates the menu bar.

Installing on a 64-bit Operating System

AutoCAD Land Desktop is available in 32-bit format only, but may be installed on a computer that has a 64-bit operating system.

Known Issues

- The Map ➤ Image ➤ Insert command does not work in this configuration.
- Additional add-on programs may not install correctly using this configuration.
- Network deployments do not install on a 64-bit operating system. As a workaround, do the following:
1. At each computer workstation where you want to install a network version, insert the installation media and run the AutoCAD Land Desktop setup program.

2. On the installation interface, click the Install Products option.

3. On the Review-Configure-Install page, click the Configure Installation option.

4. On the Select the License Type page, select Network License and specify the server model and the name of the server.

**Activating Network Licenses**

If you are installing AutoCAD Civil 3D 2009 and AutoCAD Civil 3D Land Desktop Companion 2009 on the same machine, please note that activating one product (AutoCAD Civil 3D or AutoCAD Civil 3D Land Desktop Companion) also activates the other product. It does not matter which product is activated first.

[Please send us your comment about this page]
F1 Help on Tooltips

Displaying context-sensitive Help topics from tooltips for Land Desktop items is not available. For example, if you click the Menu Browser button, and then hover the mouse pointer over Projects ➤ Project Manager, a tooltip for the Project Manager command is displayed. If you press the F1 button while this tooltip is displayed, the Land Desktop Help window is displayed. The right pane of the Help window displays "The page cannot be displayed".

Pressing the F1 button on tooltips for AutoCAD and Map 3D features displays a context-sensitive Help topic in the right pane of the Help window. For example, if you click the Menu Browser button, and then hover the mouse pointer over File ➤ New Sheet Set, the tooltip for the New Sheet Set command is displayed. If you press the F1 button while this tooltip is displaying, the Help topic for the NEWSHEETSET command is displayed.

Adobe Flash Is Required to View Certain Documentation Features

Adobe Flash Player is required to view the New Features Workshop and animations in the Help system.

Adobe Flash Player is no longer included as an installed component of AutoCAD Land Desktop. When attempting to run Adobe Flash Player dependent components, such as the New Features Workshop, a dialog box will appear prompting you to install Adobe Flash Player if it is not already on your computer. If this dialog appears, click Install to install the latest version of Adobe Flash Player.

Commands Not Available In Command Line History

After running a command from a menu or a toolbar, it may not be available in the command line history by using the Up arrow on the keyboard. Only a partial
list of recently-used commands may be available.

As a workaround, you can right-click in the command line and click Recent Commands to access the six most recently-used commands.

**Using Quick Properties Causes Pause After Selecting Object**

The Quick Properties mode (QPMODE) is not enabled by default in AutoCAD Land Desktop. If you enable it, a long pause will occur the first time you select an object in an AutoCAD Land Desktop drawing session.

**Display Issues For Drawings with Large Coordinates**

In some situations, AutoCAD Land Desktop models may not be displayed correctly when rendered, animated, or viewed with certain visual styles. The model or parts of it disappear, do not display materials, or may appear to have holes.

Usually these errors occur if the drawing has large coordinates. If you xref the drawing into another drawing and move the origin to a lower coordinate (closer to 0,0), the viewing commands will work as expected.

**To prevent these display errors**

1. Open the drawing in AutoCAD Land Desktop.
2. Zoom to the extents of the drawing.
3. Move the drawing cursor to the approximate center of the graphics extents.
4. Write down the coordinates (X,Y,Z).
5. Start a new drawing from one of the AutoCAD Land Desktop templates.
6. Attach the original drawing as an xref.
7. Specify the insertion location as (-X,-Y,-Z), using the coordinates you obtained in Step 4 above and entering minus (-) signs in front of each. This will result in the approximate center of the graphics extents being positioned at 0,0 when the xref is attached.
8. Render the drawing or set your specific visual style.
AutoCAD Map 3D Help Topics

Note that some AutoCAD Map 3D Help topics that describe AutoCAD Map 3D features that refer to menus and options that are not available in Land Desktop, or that are available from a different menu. An example of this is importing DGNs. The AutoCAD Map 3D Help topic "Overview of Importing Files" indicates that under the File menu ➤ Import, there is a Vector File option. In AutoCAD Land Desktop, this feature is available from the Map menu ➤ Tools ➤ Import.

Note that the AutoCAD Map 3D tutorials are located in \Program Files\AutoCAD Land Desktop 2009\Help\Map 3D Tutorials. The AutoCAD Map 3D Help topics and tutorials reference this location for the AutoCAD Map 3D tutorials: \Program Files\AutoCAD Map 3D 2009\Help\Map 3D Tutorials.
This Readme contains important information about AutoCAD Map 3D 2009 that may not be included in the printed documentation or in Help.

Topics in this section

- Installation and Setup
- Custom User Interface
- Bringing In Data
- Joining Data
- Annotation
- Feature Editing
- Filter Expressions
- Other Known Issues
- New Commands

Please send us your comment about this page
Installation and Setup

**Side-by-Side Installation with Autodesk Topobase**

You cannot install AutoCAD Map 3D 2009 on a system with Autodesk Topobase. Launching AutoCAD Map 3D on such a system will result in an unexpected failure.

**Clearing Cache With Unsaved Data Causes AutoCAD Map 3D To Quit Unexpectedly**

If you clear the cache before you have saved all of your data, AutoCAD Map 3D will quit unexpectedly. Be sure that you have saved all of your data before clearing your cache.

**Managing FDO Users on Oracle XE**

To use the FDO User Manager on Oracle XE, you must first create the F_USER_ROLE. To create this role, do the following:

In SQLPlus, connect as SYS and execute the following:

```sql
grant CREATE USER, DROP USER, ALTER USER, CREATE SESSION, ALTER SESSION, ANALYZE ANY, CREATE ANY TABLE, CREATE ANY CLOG, CREATE ANY TABLESPACE, CREATE ANY USER, CREATE ANY DIRECTORY, CREATE ANY OPERATIONS, CREATE ANY SOURCE, CREATE ANY SEQUENCE, CREATE ANY SYNONYM, CREATE ANY VIEW, CREATE ANY TYPE, CREATE ANY TRIGGER, CREATE ANY PROCEDURE, CREATE ANY JOB, CREATE ANY EVENT, GRANT ANY ROLE, GRANT ANY PRIVILEGE, GLOBAL QUERY REWRITE, WM_ADMIN_ROLE, grant any object privilege to f_user_role;
grant select on sys.v_$session to f_user_role;
grant select on sys.dba_role_privs to f_user_role;
grant select on sys.dba_roles to f_user_role;
```

**Managing FDO Users on Oracle 10g or 11g**

To use the FDO User Manager on Oracle 10g or 11g, you must first create the F_USER_ROLE. To create this role, do the following:

In SQLPlus, connect as SYS and execute the following:

```sql
grant CREATE USER, DROP USER, ALTER USER, CREATE SESSION, ALTER SESSION, ANALYZE ANY, CREATE ANY TABLE, CREATE ANY CLOG, CREATE ANY TABLESPACE, CREATE ANY USER, CREATE ANY DIRECTORY, CREATE ANY OPERATIONS, CREATE ANY SOURCE, CREATE ANY SEQUENCE, CREATE ANY SYNONYM, CREATE ANY VIEW, CREATE ANY TYPE, CREATE ANY TRIGGER, CREATE ANY PROCEDURE, CREATE ANY JOB, CREATE ANY EVENT, GRANT ANY ROLE, GRANT ANY PRIVILEGE, GLOBAL QUERY REWRITE, WM_ADMIN_ROLE, grant any object privilege to f_user_role;
```
grant select on sys.v_$session to f_user_role;
grant select on sys.dba_role_privs to f_user_role;
grant select on sys.dba_roles to f_user_role;
Error In Customize User Interface Dialog Box

When you launch the Customize User Interface dialog box, you will see an Unhandled Exception error the first time you click on a workspace. When you see this error, click Continue. You can safely ignore this error.
Connecting to ArcSDE Data

AutoCAD Map 3D 2009 does not support connections to ArcSDE data sources running on the Windows 2000 operating system.

Importing SDF Data

If you import an SDF file that you created by exporting DWG data to SDF, you may need to map the feature layers to drawing layers manually. Although the entries in the Import dialog box may look correct, the import operation may prepend schema names to each layer name. To resolve this problem, select each incoming layer name in the Drawing Layer column and manually select the appropriate drawing layer for that feature.

Connecting to Oracle on Windows Vista

You cannot connect to an Oracle database from a limited user account in Windows Vista. To connect to an Oracle database in Windows Vista, log on to AutoCAD Map 3D as an administrative user.

Moving Drawings Between Systems

If you want to move your drawing from one computer to another, make sure that you have checked in all your features. If you do not check in all your features, AutoCAD Map 3D will not be able to populate the feature cache on the computer to which you have moved your drawing.

Please send us your comment about this page
Joining Data

Errors When Joining Two Secondary Tables to a Primary Table

When joining two secondary tables to a primary table, you may see the following erroneous error message: “Warning: there is another operation in progress that prevents executing the current one.” Despite this error message, the data should be joined as expected.

When joining two secondary tables to a primary table, clicking Undo may result in an unexpected failure of AutoCAD Map 3D.

Please send us your comment about this page
Text Justification in Annotation Layers

Text justification options do not work at the layer level for annotation layers. The text is always centered.

Please send us your comment about this page
Editing Geospatial Features

AutoCAD Map 3D 2009 allows you to edit geospatial features either with the usual geospatial editing commands (such as MAPFEATUREEDIT) or with AutoCAD editing commands (such as PEDIT). Use the Feature Editing Options dialog box to select your preferred editing options. Select “Check out features as AutoCAD drawing objects” to edit your features using AutoCAD editing commands. Select “Check out features as Geospatial features” to edit your features using geospatial editing commands.

Cycling Through Grip Edit Commands on FDO Features

If you use the space bar to cycle through grip edit commands when editing FDO features, AutoCAD Map 3D may quit unexpectedly. To work around this issue, do not cycle through grip edit commands using the space bar past the MIRROR command. Press Escape to cancel the command, then repeat your grip editing sequence. You can also use editing commands directly rather than as subcommands in the grip-edit sequence.

Cycling through grip edit commands works as expected on AutoCAD drawing objects.

Buffering Features With No Identity Property

Buffering a feature from a layer that has no identity property will cause AutoCAD Map 3D to quit unexpectedly. To work around this issue, do one of the following:

- Open the data source and find the layer that does not include an identity property. Enter an identity property for that layer.
- Create a copy of the layer (using Bulk Copy, for example). The new
copy of the layer should include an autogenerated identity property. Buffer the feature on your new layer.

Please send us your comment about this page
Using Calculated Fields When Querying to Filter Data

If you use a calculated field when querying to filter data, you may see an FDO error message. To address this error and continue with your query, simply refresh the layer.
**Other Known Issues**

**Coordinate Systems May Display Incorrectly**

Certain SHP folders may contain erroneously-formed Well Known Text (WKT) coordinate projection descriptions in their .PRJ files. In these cases, the coordinate system reported in the Data Connect dialog may appear to be incorrect. Depending on the actual WKT text encountered, the discrepancy may be innocuous, and the data will be added to the map correctly. For example, some WGS-84 Lat-Lon WKT strings may inadvertently be reported as another Lat-Lon coordinate system, such as Antarctic98.LL (which has the same mathematical definition as LL84).

**Points Created in AutoCAD Map 3D Are Not Visible in ESRI ArcGIS**

If you create new points in a SHP file using AutoCAD Map 3D, you may not be able to view those points in ESRI ArcGIS. To work around this problem, take the following steps:

1. Open the Editor toolbar (Click Tools > Editor toolbar)
2. On the Editor toolbar, click Editor > Start Editing.
3. On the Editor toolbar, click Editor > Save Edits.

**Change in Behavior for Joined Data**

In AutoCAD Map 3D 2009, you are no longer able to edit one-to-many joins or inner joins.

---

Please send us your comment about this page
<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>MAPAUTOCHECKOUT</td>
<td>Sets option to automatically check out features when editing</td>
</tr>
<tr>
<td>MAPFEATUREEDITOPTIONS</td>
<td>Sets feature edit set options.</td>
</tr>
<tr>
<td>MAPFEATUREMERGE</td>
<td>Merges geospatial features.</td>
</tr>
<tr>
<td>MAPFEATURESPLIT</td>
<td>Splits geospatial features.</td>
</tr>
<tr>
<td>MAPIGNORESPLITMERGERULES</td>
<td>Overrides split and merge rules for your feature edit set.</td>
</tr>
<tr>
<td>MAPPLOTTRANSPARENCY</td>
<td>Sets options for plotting transparent features.</td>
</tr>
<tr>
<td>MAPTEXTCREATE</td>
<td>Creates annotation text.</td>
</tr>
<tr>
<td>MAPTEXTEDIT</td>
<td>Edits annotation text.</td>
</tr>
<tr>
<td>MAPTEXTLAYERCREATE</td>
<td>Creates an annotation text layer.</td>
</tr>
</tbody>
</table>
Please send us your comment about this page
This Readme contains important information about AutoCAD 2009 that may not be included in the printed documentation or in Help.

Topics in this section

- [Installation, Configuration and Hardware](#)
- [Graphics Card Driver Update](#)
- [Draw and Edit](#)
- [Developer Information](#)
- [Command and System Variable History](#)
- [Product Removal](#)
- [Trademarks](#)
Installation, Configuration and Hardware

Installation and Configuration

Installing from Dual CD/DVD ROM Drive Systems

Installation fails if you attempt to install AutoCAD 2009 installation discs in different drives of a dual CD/DVD ROM drive system. You must use the same disc drive in order to complete the installation process.

HTML Help Fails When Launched from a Network Drive

You cannot launch the Help System from a network drive. A "Page Cannot Be Displayed" warning is displayed. This limitation is a result of the Windows Security Update #896258 from Microsoft.

Licensing

To Install the Autodesk Network License Manager

1. On the AutoCAD 2009 Installation wizard, click Install Tools and Utilities.

2. On the Select the Products to Install page, ensure that the Network License Manager is selected. Click Next.

3. Review the Autodesk software license agreement for your country or region. You must accept this agreement to proceed with the installation. Choose your country or region and click I Accept. Click Next.  
   **Note** If you do not agree to the terms of the license and wish to terminate the installation, click Cancel.


5. If you selected multiple products on the Select Products to Install page (Step 3), then click the Network License Manager tab.
6. Do one of the following:
   - Accept the default installation path (C:\Program Files\Autodesk Network License Manager).
   - Click [...] to specify a different path. If you enter a path that does not exist, a new folder is created using the name and location you provide.

   **Note** Do not install the Network License Manager on a remote drive. When you install the Network License Manager files, you must provide a path to a local drive. You must also specify the drive letter; the universal naming convention (UNC) is not supported.


Running a Network License Manager on Microsoft Windows Vista

When starting the network version of AutoCAD 2009 on a Microsoft Windows Vista workstation, you may encounter licensing error -15 if the license manager is running on Windows Vista (FLEXlm server version 11.4.100). Do the following:

   - Install the latest Service Pack and updates for Microsoft Windows Vista.

If you continue to encounter errors, do the following:

   - On the Start menu (Windows Vista), click Control Panel » Network and Sharing Center » Manage Network Connections, right-click on Local Area Connection. Select Properties. Uncheck Internet Protocol 6 (TCP/IPv6). Click OK.

To Install the Network License Activation Utility

1. On the AutoCAD 2009 Installation wizard, click Install Tools and Utilities.

2. On the Select the Products to Install page, ensure that the Network License Activation Utility is selected. Click Next.

3. Review the Autodesk software license agreement for your country or region. You must accept this agreement to proceed with the installation. Choose your country or region and click I Accept. Click Next.
Note If you do not agree to the terms of the license and wish to terminate the installation, click Cancel.


5. If you selected multiple products on the Select Products to Install page (Step 3), then click the Network License Activation Utility tab.

6. Do one of the following:
   - Accept the default installation path (C:\Program Files\Autodesk Network License Manager\Network License Activation Utility\enu\).
   - Click [...] to specify a different path. If you enter a path that does not exist, a new folder is created using the name and location you provide.


FlexLM License is Created in Two Locations

The FLEXlm License Finder dialog box may not display upon each launch of AutoCAD 2009 for non-administrative users who are using Windows Vista 64-bit. This is because the license server path information is stored in the HLKM\SOFTWARE\Wow6432Node path, which is not accessible to non-administrative users.

To fix this problem, replicate the license server path information stored in the above path to go to the HKLM\SOFTWARE\FLEXlm License Manager path.

Hardware

Graphics Card Driver Update

For the best program performance, verify and update your graphics card driver. For more information, see Graphics Card Driver Update.

Remote Access Applications

It is not recommended that you use any type of remote access application in conjunction with AutoCAD 2009 when it is configured to use hardware
acceleration. Most remote access applications cannot support hardware acceleration, which can cause general display failure and instability. If you need to use remote access applications, disable hardware acceleration or use the /NOHARDWARE command line switch to start AutoCAD 2009 in Software mode.

Hardware Certification Database

To download and install the latest hardware certification XML file, visit the Hardware Certification website at http://www.autodesk.com/autocad-graphicscard.
You should verify and update your graphics card driver to optimize AutoCAD 2009. Use the following procedure to identify your current graphics card driver.

**To identify your graphics card driver**

2. At the Command prompt, enter `3dconfig`.
3. In the Adaptive Degradation and Performance Tuning dialog box, click View Tune Log.
4. Review the 3D Device section for information about your system's graphics card driver and driver version.

If you find that you do need to update your driver, visit [http://www.autodesk.com/autocad-graphicscard](http://www.autodesk.com/autocad-graphicscard) to find a certified driver for your graphics card. If you do not find one, visit the graphics card manufacturer's website.

**Note** If the graphics card manufacturer does not have an updated driver, check the system manufacturer's website. Companies like IBM, Hewlett Packard, and Dell often supply their own system drivers.

---

Please send us your comment about this page
**Draw and Edit**

---

**Drawing Environment**

**Tool Palettes**

Tool palettes created in the current release should not be used in previous releases.

**Plot and Publish DWF Files**

AutoCAD 2009 for 64-bit halts unexpectedly when publishing DWF drawings containing text, multiline text (mtext), and attributes that use the CityBluePrint font. To repair this problem, download and install the Windows security update available at [http://www.microsoft.com/technet/security/Bulletin?MS06-002.mspx](http://www.microsoft.com/technet/security/Bulletin?MS06-002.mspx).

**Opening Sample Drawing Files in Windows Vista**

Due to Windows Vista restrictions, all sample files found in the AutoCAD 2009 Sample folder and subfolders are read-only. Sheet Set Manager sample files can be opened in the Sheet Set Manager, but cannot be changed.

**Autodesk i-drop**

For i-drop to operate properly on a system running Windows Vista, the user should be set to Run as Administrator.

---

**3D Environment**

AutoCAD 2007 introduced a new 3D Modeling environment, which you can access by means of the VISUALSTYLES command and choosing any non-2D style. The 3D environment has some behavioral differences when compared to the legacy 2D drafting environment, such as:

- Draw order is not supported in 3D
• Memory usage in 3D is higher

• The **REGEN** and **REGENALL** commands do not necessarily clean up display artifacts. To reset the display, cycle **VISUALSTYLES** between 2D and non-2D styles.

Direct 3D with Microsoft Windows Vista

When Direct 3D is enabled in a Windows Vista environment, the cursor appears as black and white instead of color in non-2D visual styles. Any changes to the cursor from the Options dialog box are not enabled in this environment.

### Animation and Rendering

**Animation Output**

The Quicktime Player cannot play MOV files saved with characters that are not native to the current operating system.

Windows Vista versions K and N (available in Korea and Europe) do not come with Windows Media Player installed. In order to use the animation feature in AutoCAD 2009, download the latest version of Media Player from the Microsoft website.

**Advanced Render Settings**

In the Advanced Render Settings Dialog box, the Memory Limit field is ignored in AutoCAD 2009 for 64-bit. AutoCAD 2009 will make use of all available memory in a 64-bit environment.

### Other Drafting Issues

**External References**

Due to the external references (xref) polling cycle, you can encounter a time lag when attempting to use the Manage Xrefs icon to reload DWG xrefs. You cannot reload referenced DWG files with this method until you see the balloon notification on the Manage Xrefs icon is displayed. To expedite the reloading process, use one of the following methods:

• On the External References palette, right-click the reference drawing. Click Reload.
On the External References palette, click Reload All References.

At the Command prompt, enter -xref. Use the Reload option.

Text and Language

Multiple-Language Support

When you copy and paste characters that have been created using a language other than the system language, the characters may not be displayed correctly.

To correct the display to show the original language

1. Double-click the text to open it in the In-Place Text Editor.

2. Right-click inside the editor. Click Character Set and select the original language.
Developer Information

Changes That May Affect Scripts

Changes to the following commands or system variables may affect pre-existing scripts:

**EXTEND**

For the EXTEND command, if you do not select an object at the Select Objects to Extend prompt, you are now prompted to specify the opposite corner of a crossing window. This change may affect pre-existing scripts that call EXTEND and supply a pick point that selects no objects. You can fix legacy scripts by omitting points that do not select objects.

**INSERT**

If you use the Scale Uniformly option in the Block Definition dialog box, you are no longer prompted to enter separate scale factors for X,Y,Z coordinates when you insert a block using the -INSERT command.

**MENULOAD**

By default, the MENULOAD command loads only CUI files in AutoCAD 2006 or later releases. To load an MNU or MNS file in AutoCAD 2006 or later release, you must explicitly include the extension in the file name, as shown in the following example:

(command "menuload" "myMenu.mnu")

However, rather than changing your code, it is strongly recommended that you open your legacy menu files in AutoCAD 2009 before running applications that use them. AutoCAD 2009 automatically converts them to CUI files, and the CUI files are loaded by existing code that uses the file name without an extension.

Legacy code that specifies an MNU, MNS, or MNC extension should be changed to reference a CUI file, and AutoCAD 2007-based applications should ship with CUI files, not MNU, MNS, or MNC files.
**TRIM**

For the TRIM command, if you do not select an object at the Select Objects to Trim prompt, you are now prompted to specify the opposite corner of a crossing window. This change may affect pre-existing scripts that call TRIM and supply a pick point that selects no objects. You can fix legacy scripts by omitting points that do not select objects.

**ActiveX and VBA**

VBA scripts that run at startup should check whether the AutoCAD 2009 process is visible or invisible. If the process is invisible, the script should not execute, because the process may be performing background plotting or publishing operations. To check whether the AutoCAD 2009 process is visible or invisible, you can use the Visible property of the Application object in the AutoCAD 2009 Object Model.

**Quick Properties**

To maximize performance when scripts or LISP rountines are run, the Quick Properties panel is disabled. Completion of the routine restores functionality.

[Please send us your comment about this page]
Where to Learn About AutoCAD 2009

Use the following resources to find more information about AutoCAD 2009:

- New Features Workshop (Help menu)
- Help system (Help menu)
- Developer Help (Help menu > Additional Resources)
- Autodesk User Group International (AUGI) (Help menu > Additional Resources)
- Autodesk website at [http://www.autodesk.com](http://www.autodesk.com)

New Commands

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ACTRECORD</td>
<td>Starts the Action Recorder.</td>
</tr>
<tr>
<td>ACTSTOP</td>
<td>Stops the Action Recorder and provides the option of saving the recorded actions to an action macro file.</td>
</tr>
<tr>
<td>-ACTSTOP</td>
<td>Stops the Action Recorder and provides the option of saving the recorded actions to an action macro file.</td>
</tr>
<tr>
<td><strong>ACTUSERINPUT</strong></td>
<td>Inserts a request for user input into an action macro.</td>
</tr>
<tr>
<td><strong>ACTUSERMESSAGE</strong></td>
<td>Inserts a message that will be viewed during playback.</td>
</tr>
<tr>
<td><strong>-ACTUSERMESSAGE</strong></td>
<td>Inserts a user message into an action macro.</td>
</tr>
<tr>
<td><strong>ALLPLAY</strong></td>
<td>Plays all named views in current drawing.</td>
</tr>
<tr>
<td><strong>BACKGROUND</strong></td>
<td>Sets up the background for your view.</td>
</tr>
<tr>
<td><strong>CLASSICLAYER</strong></td>
<td>Manages layer and layer properties.</td>
</tr>
<tr>
<td><strong>DASHBOARD</strong></td>
<td>Opens the Dashboard window. Routed to the RIBBON command</td>
</tr>
<tr>
<td><strong>-DGNEXPORT</strong></td>
<td>Creates one or more DGN files from the current drawing.</td>
</tr>
<tr>
<td><strong>-DGNIMPORT</strong></td>
<td>Imports the data from a DGN file into a new DWG file.</td>
</tr>
<tr>
<td><strong>DGNLAYERS</strong></td>
<td>Controls the display of layers in a DGN underlay.</td>
</tr>
<tr>
<td><strong>DGNMAPPING</strong></td>
<td>Allows users to create and edit user-defined DGN mapping setups.</td>
</tr>
<tr>
<td>Command</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>DWFFORMAT</td>
<td>Sets the default DWF format to the selected format to DWF or DWFx for the PUBLISH, 3DDWF, and EXPORT commands.</td>
</tr>
<tr>
<td>EDITSHOT</td>
<td>Opens the Edit View dialog box with the Shot Properties tab active.</td>
</tr>
<tr>
<td>EXPORTLAYOUT</td>
<td>Exports all visible objects from current layout to the model space of a new drawing.</td>
</tr>
<tr>
<td>HIDEPALETTES</td>
<td>Hides currently displayed palettes (including the command line).</td>
</tr>
<tr>
<td>IMPRESSION</td>
<td>Gives a CAD drawing a hand-drawn look by exporting it for rendering in Autodesk Impression.</td>
</tr>
<tr>
<td>LAYERCLOSE</td>
<td>Closes Layer Properties Manager.</td>
</tr>
<tr>
<td>NAVSMOTION</td>
<td>Displays the ShowMotion interface.</td>
</tr>
<tr>
<td>NAVSMOTIONCLOSE</td>
<td>Closes the ShowMotion interface.</td>
</tr>
<tr>
<td>NAVSWHEEL</td>
<td>Displays the</td>
</tr>
<tr>
<td>Command</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>NAVVCUBE</td>
<td>Controls the visibility and display properties of the ViewCube.</td>
</tr>
<tr>
<td>NEWSHOT</td>
<td>Creates a named view with motion that is played back when viewed with ShowMotion.</td>
</tr>
<tr>
<td>QVDRAWING</td>
<td>Displays open drawings and layouts in a drawing in preview images.</td>
</tr>
<tr>
<td>QVDRAWINGCLOSE</td>
<td>Closes preview images of open drawings and layouts in a drawing.</td>
</tr>
<tr>
<td>QVayout</td>
<td>Displays preview images of model space and layouts in a drawing.</td>
</tr>
<tr>
<td>QVLAYOUTCLOSE</td>
<td>Closes preview images of model space and layouts in a drawing.</td>
</tr>
<tr>
<td>RIBBON</td>
<td>Opens the Ribbon window.</td>
</tr>
<tr>
<td>RIBBONCLOSE</td>
<td>Closes the Ribbon window.</td>
</tr>
<tr>
<td>SEQUENCEPLAY</td>
<td>Plays the named views in one view category.</td>
</tr>
<tr>
<td>SHOWPALETTEs</td>
<td>Restores the display of hidden palettes.</td>
</tr>
<tr>
<td>VIEWGO</td>
<td>Restores a named view.</td>
</tr>
<tr>
<td>------------</td>
<td>------------------------</td>
</tr>
<tr>
<td>VIEWPLAY</td>
<td>Plays the animation associated with a named view.</td>
</tr>
</tbody>
</table>

### Changed Commands

<table>
<thead>
<tr>
<th>Changed Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>DASHBOARDCLOSE</td>
<td>Closes the Dashboard window. Routed to the RIBBONCLOSE command.</td>
</tr>
<tr>
<td>DGNATTACH</td>
<td>Attaches a DGN underlay to the current drawing.</td>
</tr>
<tr>
<td>-DGNATTACH</td>
<td>Attaches a DGN underlay to the current drawing.</td>
</tr>
<tr>
<td>DGNEXPORT</td>
<td>Creates one or more DGN files from the current drawing.</td>
</tr>
<tr>
<td>DGNIMPORT</td>
<td>Imports the data from a DGN file into a new DWG file.</td>
</tr>
<tr>
<td>GEOPGRAPHICLOCATION</td>
<td>Specifies the geographic location information for a drawing file.</td>
</tr>
<tr>
<td>LAYER</td>
<td>Manages layers and</td>
</tr>
</tbody>
</table>
NEWVIEW

CREATES A NAMED VIEW WITHOUT MOTION.

QUICKCUI

DISPLAYS THE CUSTOMIZE USER INTERFACE DIALOG BOX IN A COLLAPSED STATE.

VPLAYER

SETS LAYER VISIBILITY WITHIN VIEWPORTS.

## New System Variables

<table>
<thead>
<tr>
<th>System Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ACTPATH</td>
<td>Specifies the additional paths to use when locating available action macros for playback.</td>
</tr>
<tr>
<td>ACTRECORDSTATE</td>
<td>Specifies the current state of the Action Recorder.</td>
</tr>
<tr>
<td>ACTRECPATH</td>
<td>Specifies the path used to store new action macros.</td>
</tr>
<tr>
<td>ACTUI</td>
<td>Controls the behavior of the Action Recorder panel when recording and playing back macros.</td>
</tr>
<tr>
<td>CAPTURETHUMBNAI</td>
<td>Specifies if and when thumbnails are</td>
</tr>
<tr>
<td>Variable</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------</td>
<td>----------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>DGNIMPORTMAX</td>
<td>Limits the number of elements that are translated when importing a DGN file. This limit prevents the program from running out of memory and suspending when importing large DGN files.</td>
</tr>
<tr>
<td>DGNMAPPINGPATH</td>
<td>Stores the location of the dgnsetups.ini file where DGN mapping setups are stored.</td>
</tr>
<tr>
<td>GEOLATLONGFORMAT</td>
<td>Controls the format of the latitude and longitude values in the Geographic Location dialog box, and the coordinate status bar in Geographic mode.</td>
</tr>
<tr>
<td>GEOMARKERVISIBILITY</td>
<td>Controls the visibility of geographic markers.</td>
</tr>
<tr>
<td>HIDEXREFSCALES</td>
<td>Controls the display of Xref scales. 0- Xref scales are displayed 1- Xref scales are hidden.</td>
</tr>
<tr>
<td>LAYERDLGMODE</td>
<td>Sets the flavor of the Layer Properties Manager that will be defined for the use of</td>
</tr>
</tbody>
</table>
the LAYER command. The LAYER command is mapped to execute either the CLASSICLAYER or LAYERPALETTE.

<table>
<thead>
<tr>
<th><strong>MENU BAR</strong></th>
<th>Controls the display of the menu bar.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>MTEXTTOOLBAR</strong></td>
<td>Controls the display of the Text Formatting toolbar.</td>
</tr>
<tr>
<td><strong>NAVSWHEELMODE</strong></td>
<td>Specifies the current mode of the SteeringWheels.</td>
</tr>
<tr>
<td><strong>NAVSWHEELOPACITYBIG</strong></td>
<td>Controls the opacity of the big SteeringWheels.</td>
</tr>
<tr>
<td><strong>NAVSWHEELOPACITYMINI</strong></td>
<td>Controls the size of the mini SteeringWheels.</td>
</tr>
<tr>
<td><strong>NAVSWHEELSIZEBIG</strong></td>
<td>Specifies the size of the big SteeringWheels.</td>
</tr>
<tr>
<td><strong>NAVSWHEELSIZEMINI</strong></td>
<td>Specifies the size of the mini SteeringWheels.</td>
</tr>
<tr>
<td><strong>NAVSWHEELWALKSPEED</strong></td>
<td>Controls the speed of Walk from wheel.</td>
</tr>
<tr>
<td><strong>NAVVCUBEDISPLAY</strong></td>
<td>Controls the display of the ViewCube on the canvas when the 3D graphic system is active.</td>
</tr>
<tr>
<td>Setting</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>NAVVCUBELOCATION</td>
<td>Identifies the corner in a viewport where the ViewCube is displayed.</td>
</tr>
<tr>
<td>NAVVCUBEORIENT</td>
<td>Controls whether the ViewCube reflects the current UCS or WCS.</td>
</tr>
<tr>
<td>NAVVCUBESIZE</td>
<td>Controls the display size of the ViewCube.</td>
</tr>
<tr>
<td>NAVVCUBOPACITY</td>
<td>Controls the opacity of the ViewCube when inactive.</td>
</tr>
<tr>
<td>OPENPARTIAL</td>
<td>Controls whether a drawing can be worked on before it is fully open.</td>
</tr>
<tr>
<td>PREVIEWTYPE</td>
<td>Specifies the view to use for the drawing thumbnail.</td>
</tr>
<tr>
<td>PUBLISHHATCH</td>
<td>Controls whether hatch patterns published to DWF format (DWF File or DWFx File) are treated as a single object when opened in Autodesk Impression.</td>
</tr>
<tr>
<td>QPLOCATION</td>
<td>Sets the location mode of Quick Properties panel.</td>
</tr>
<tr>
<td>QPMODE</td>
<td>Sets the on or off state of Quick Properties</td>
</tr>
<tr>
<td>Variable</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>QVDRAWINGPIN</td>
<td>Controls the default display state of preview images of drawings.</td>
</tr>
<tr>
<td>QVLAYOUTPIN</td>
<td>Controls the default display state of preview images of model space and layouts in a drawing.</td>
</tr>
<tr>
<td>RIBBONSTATE</td>
<td>Indicates whether the ribbon palette is open or closed.</td>
</tr>
<tr>
<td>ROLLOVERTIPS</td>
<td>Controls the display of object rollover tooltips in the application. The content in tooltips can be customized in the Customize User Interface (CUI) editor.</td>
</tr>
<tr>
<td>SHOWMOTIONPIN</td>
<td>Controls the default display state of the thumbnail shots.</td>
</tr>
<tr>
<td>SHOWPALETTE</td>
<td>This corresponds to the shortcut key (CTRL+SHIFT+H) to show or hide palettes.</td>
</tr>
<tr>
<td>STATUSBAR</td>
<td>Controls the display of the application and drawing status bars.</td>
</tr>
<tr>
<td>THUMBSIZE</td>
<td>Specifies the maximum generated panel.</td>
</tr>
</tbody>
</table>
## Changed System Variables

<table>
<thead>
<tr>
<th>Changed System Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CROSSINGAREACOLOR</td>
<td>Controls the color of the selection area during crossing selection. The valid range is 1 to 255. The SELECTIONAREA system variable must be on.</td>
</tr>
<tr>
<td>GRIPCOLOR</td>
<td>Controls the color of nonselected grips. The valid range is 1 to 255.</td>
</tr>
<tr>
<td>GRIPHOT</td>
<td>Controls the color of selected grips. The valid range is 1 to 255.</td>
</tr>
<tr>
<td>GRIPHOVER</td>
<td>Controls the fill color of an unselected grip when the cursor pauses over it. The valid range is 1 to 255.</td>
</tr>
<tr>
<td>OSMODE</td>
<td>Sets running object snaps.</td>
</tr>
<tr>
<td>TABLETOOLBAR</td>
<td>Controls the display of the Table toolbar.</td>
</tr>
<tr>
<td>WINDOWAREACOLOR</td>
<td>Controls the color of the transparent</td>
</tr>
</tbody>
</table>
selection area during window selection. The valid range is 1 to 255. SELECTIONAREA must be on.
Product Removal

To Uninstall AutoCAD 2009 [Windows XP]

1. On the Start menu (Windows), click Settings ➤ Control Panel ➤ Add or Remove Programs.
2. Select AutoCAD 2009. Click Change/Remove.
4. On the Uninstall AutoCAD 2009 page, click Next.
5. Click Finish.

To Uninstall AutoCAD 2009 [Windows Vista]

1. On the Start menu (Windows), click Settings ➤ Control Panel ➤ Uninstall a Program.
   If the User Account Control dialog box displays, click Continue.
4. On the Uninstall AutoCAD 2009 page, click Next.
5. Click Finish.

Please send us your comment about this page

The following are registered trademarks or trademarks of Autodesk Canada Co. in the USA and/or Canada and other countries: Backburner, Discreet, Fire,
Flame, Flint, Frost, Inferno, Multi-Master Editing, River, Smoke, Sparks, Stone, and Wire.

Please send us your comment about this page